
 

 

 

© 2014 Greenway Health, LLC. All rights reserved. Confidential and proprietary. 
Not for distribution except to authorized persons. Last Modified: 12/11/14 

 

SuccessEHS Release Notes 7.20 

 

Table of Contents 

 

All Modules .................................................................................................................................................. 3 

"About" Information for POC Launcher/Clinical Console Updated for Greenway ................ 3 

Changes for Inactive/Deceased Patients .......................................................................................... 3 

Problems Now Import in Order Selected ........................................................................................ 6 

RSR Report Changes 2014 .................................................................................................................. 6 

Alpha II ........................................................................................................................................................ 9 

Alpha II Update Q4 2014 ................................................................................................................... 9 

Chart Overview ......................................................................................................................................... 10 

New Last 10 Charts Accessed Quick Link ..................................................................................... 10 

Clinical Console ......................................................................................................................................... 11 

Clinical Console Report Changes .................................................................................................... 11 

Medications.NET ...................................................................................................................................... 14 

Add Medications, New Close Meds Button ................................................................................... 14 

Change in NDC Prompt Warning ................................................................................................... 14 

FDB Update October 2014 .............................................................................................................. 14 

Pharmacy Information Displays in Header Bar ............................................................................. 15 

Meaningful Use/PQRS/CQM ................................................................................................................ 16 

CQM, Changes to QRDA Wording for Measure Submission .................................................... 16 

Patient Administration ............................................................................................................................. 17 

Demographics Tab, Privacy/Consent Changes ............................................................................. 17 

System Administration ............................................................................................................................. 19 

Accounting Periods, Financial Groups Removed from Report .................................................. 19 

System Administration Console .............................................................................................................. 20 

Clinic Configuration, NDC Columns Added to Prescribed Medications Starter Set .............. 20 

Clinic Configuration, New Registry Reporting Configuration for Blood Lead Tests  (FL 
Clients Only) ....................................................................................................................................... 20 

Configure SuccessEHS, Duplicate Patient Override Checkbox Removed ............................... 23 



 

 

 

© 2014 Greenway Health, LLC. All rights reserved. Confidential and proprietary. 
Not for distribution except to authorized persons. Last Modified: 12/11/14 

 

Financial Classes, New Timely Filing Limit Option ..................................................................... 23 

HIE Consent Configuration, Restrictions for Syndromic Surveillance Outgoing Messages .. 27 

 



SuccessEHS Release Notes 7.20 3

 

 

© 2014 Greenway Health, LLC. All rights reserved. Confidential and proprietary. 
Not for distribution except to authorized persons. Last Modified: 12/11/14 

 

All Modules 

"About" Information for POC Launcher/Clinical 
Console Updated for Greenway 

Project #EHS-20258

The information in the About POC Launcher and About Clinical Console dialog boxes has 
been updated to reflect the Greenway branding. 

 

Changes for Inactive/Deceased Patients 
Project #EHS-19759, EHS-19792, 

EHS-19793, EHS-19794, EHS-19795, 
EHS-19796

Changes have been made to better record and reflect the status of inactive and deceased patients 
in the system. 
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Patient Administration 

 Inactive label – An Inactive checkbox has been added to the Demographics tab. 

 
Selecting (checking) the Inactive checkbox will display a PATIENT IS INACTIVE 
label, along with the date the patient was marked inactive and the user ID of the person 
who marked the patient inactive. 

 
The PATIENT IS INACTIVE label will also display in the following places in the 
system: 

o Charge Entry > View > Patient Demographics 

o Check In > Edit > Patient Demographics 

o Receivables > Apply Insurance Payments/Adjustments > View > Patient 
Demographics 

o Scheduling > Patient Appointment dialog > Patient Details button > 
Demographics 

o Rounds > Open Rounding list > Details button 

o Chart Overview > Patient Data > Demographics tab 

o Inquiry > View > Demographics 

o Find Patient dialog box  

 Deceased label – A DECEASED label will display in red text when the user enters a 
Date of Death on the Additional Patient Data tab in Patient Administration, 
Check In, or Charge Entry. 
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The DECEASED label will display even if the Inactive checkbox is selected (as 
deceased status overrides inactive status). The DECEASED label will display in the 
same places in the system as the INACTIVE label (listed above). 

Check In/Charge Entry 

 Warnings – A warning dialog box will display in Check In and Charge Entry if a user 
attempts to access an inactive or deceased patient.  

 
Users may click Yes to create a new visit for the patient, or No to return to the Find 
Patient dialog box and select a new patient. 

o For unposted visits in Charge Entry, the system will compare the Date of 
Service (DOS) with the Date of Death (DOD) or Inactive Date (ID) for 
deceased and inactive patients respectively. If the DOS is before the DOD or 
ID, the user will be able to apply/save changes to the patient record.  
If the DOS is after the DOD/ID, the appropriate warning will display again; 
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users may click Yes to save the data entered, or No to return to the Charges tab 
and make any necessary changes. 

Clinical Event Manager 

 CEM exclusions – Inactive and deceased patients will be excluded from all rule 
generations in the Clinical Event Manager. 

Scheduling 

 Scheduling block – Inactive and deceased patients will be prohibited from having 
appointments scheduled for them via the Scheduling module. 

Problems Now Import in Order Selected Project #EHS-19593

When importing problems into the superbill via the Import Pt Problems dialog box or into 
Medcin.NET from the Problems tab on the Import Data window, the problems will now 
import in the order in which they are selected, not the order in which they are displayed on 
screen. This will hold regardless of from where the problems are imported. 

RSR Report Changes 2014 Project #EHS-18429

The following changes have been made in the system to accommodate the updates to the Ryan 
White Services Report for 2014. 

Patient Administration 

1. The following additions have been made to the Ethnicity drop-down list on the 
Additional Patient Data tab: 

 Mexican, Mexican American, Chicano/a 

 Puerto Rican 

 Cuban 

 Another Hispanic, Latino/a or Spanish Origin 

The above ethnicities map to Hispanic/Latino for UDS reporting. 

2. Other Asian has been added to the Race field (this maps to Asian for UDS reporting). 
This includes the RHIN mappings of Asian, Iwo Jiman, Laotian, Malaysian, Maldivian, 
Nepalese, Okinawan, Pakistani, Singaporean, Sri Lankan, and Thai. 

These race/ethnicity updates have also been added to the Patient Portal. 

HIV/AIDS Reporting 

The following changes have been made on the HIV/AIDS Reporting Data Review screen in 
Clinical Console: 
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1. Demographics tab – A Sex field has been added to the Gender and Transgender 
section that displays the patient's sex as recorded in Patient Administration. 

 
2. Misc tab – A First OAMC Date after pos result field has been added to the 

HIV/AIDS Status section that allows users to document the first OAMC date for the 
patient after a positive result is diagnosed. 
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Report Changes  

For details of specific changes within the RSR report, please visit the following website:  
https://careacttarget.org/sites/default/files/file-
upload/resources/2014%20RSR%20Client%20Level%20Data%20Elements%20FINAL%2011
_14.pdf 
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Alpha II 

Alpha II Update Q4 2014 Project #EHS-19932

The Alpha II updates for Q4 2014 have been completed. 

 

 



SuccessEHS Release Notes 7.20 10

 

 

© 2014 Greenway Health, LLC. All rights reserved. Confidential and proprietary. 
Not for distribution except to authorized persons. Last Modified: 12/11/14 

 

Chart Overview 

New Last 10 Charts Accessed Quick Link Project #EHS-19760

A Last 10 Charts Accessed quick link has been added to the Chart Quick Links list in the 
main Chart Overview mode. 

 
Clicking this link will display a pop-up listing up to the last ten charts accessed by the user in 
Chart Overview. The pop up menu will include the patient’s name, patient number, and their 
date of birth. 

 
Accessing a chart from the pop-up will open the patient's chart. The last ten patient charts will 
display in the order they are first selected in the pop-up list. Once a chart is selected, it will 
be cycled out of the list after 10 separate charts are accessed; i.e., if Chart #1 is selected, it will 
cycle out of the "last 10" list once Chart #11 is accessed, even if Chart #1 is re-accessed before 
the eleventh chart slot is filled. 
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Clinical Console 

Clinical Console Report Changes 
Project #EHS-19650, EHS-19639, 

EHS-19640, EHS-19641, EHS-19617, 
EHS-19659, EHS-19673, EHS-19686

The following changes have been made to reports in Clinical Console. 

Default Selections for Reports 

 If a reports category in the Process Reports screen contains only one report, the report 
name will automatically populate in the Select Report field. 

 
 If a report has only one search criteria connected to the report, the criteria will 

automatically populate in the Show Data Where The field. 
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New Report Categories/Reports 

The following new reports categories/reports have been added to Clinical Console. 

 Schedule Reports – The following reports have been migrated from classic Chart to 
the (new) Schedule Reports category: 

o Appointments for Provider and Date Range 
o Today's Appointments 

 
No criteria or functions have changed in the migration. 

 Patient Information – The following report has been migrated from classic Chart to 
the (new) Patient Information category: 

o Patient Demographics 

 
No criteria or functions have changed in the migration. 

 Flag Reports – The Flag Reports category includes the following: 

o New Reports 

 Flag Report By Selected Patient – Replaces the All Flags For 
Selected Patient and Active Flags For Selected Patient reports in 
classic Chart. 

 Flags Per Provider – Replaces the All Provider Flags and All Active 
Provider Flags in classic Chart. 

 Flags For Selected Encounter – Replaces the Flags By Encounter 
report in classic Chart. 
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o Include Released Flags – An Include Released Flags checkbox has been 

added to the Find Data That Match These Criteria section for the Active 
Flags by Provider, Flags for Selected Encounter, and Flags for Selected 
Patient reports. When selected (checked), released flags will be included in the 
appropriate report pull. 

 Order Reports – The following report has been migrated from the Patient Alerts tab 
in classic Chart to the Order Reports category: 

o Deferred Orders for Selected Patient 

 
No criteria or functions have changed in the migration. 
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Medications.NET 

Add Medications, New Close Meds Button Project #EHS-19754

A Close Meds button has been added to the Overview and Med Details tabs on the Add 
Meds screen in Medications.NET. 

 
Clicking this button from either tab will exit out of Medications.NET completely. 

Change in NDC Prompt Warning Project #BHML3-303

The text in the Warning prompt on the Add Medications window when prescribing or 
renewing a medication without an NDC number has changed to the following: 

 
"Warning: Please look for an equivalent medication. This medication does not have an 
associated NDC, therefore it cannot be sent via eRx." 

FDB Update October 2014 Project #EHS-19901

The FDB update for October 2014 has been completed. 
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Pharmacy Information Displays in Header Bar Project #EHS-19749

Pharmacy information for a patient will now display in a Pharm: section in the blue header bar 
on both the Med Summary and Add Meds screens in Medications.NET. 

 
An (I) designation after the pharmacy name indicates that the pharmacy is inactive in the 
system. 
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Meaningful Use/PQRS/CQM 

CQM, Changes to QRDA Wording for Measure 
Submission 

Project #EHS-19866

Changes have been  made to the wording on the Warning dialog box for users generating CQM 
measure reports on the Incentive Programs window. 

 
Previously, if a planned report had fewer than nine measures selected or no measures with 
Medicare data, the report would not generate. In this current release, users will be able to 
generate the CQM report with fewer than nine measures or without Medicare data by clicking 
OK on the Warning dialog box. 
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Patient Administration 

Demographics Tab, Privacy/Consent Changes Project #EHS-19758

Changes have been  made to the privacy/consent settings on the Demographics tab in Patient 
Administration that enable users to more easily discern the privacy/consent status of patients. 

Color-Coding: Color-coding has been added to the Privacy/Consent button as follows: 

 Green highlights – Both the HIPAA privacy statement and the consent form have 
been documented as active and are not expired on the Privacy/Consent Information 
screen. 

 

 Yellow highlights – One or the other (privacy policy or consent form) has expired for 
the patient. 

 

 Red highlights – Neither the privacy policy nor the consent form are currently 
documented as active (i.e., neither has been documented, or both have expired). 

 
Order/Immunization Detail Icon: A Privacy/Consent Info button has been added to the 
menu ribbon in all Order Detail and Immunization Detail screens in Clinical Console to 
display the privacy/consent status for the patient. 

 
The Privacy/Consent Info icon displayed as follows based on the patient's status: 
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 If both privacy and consent documented and are not expired, a checkmark icon displays: 

 

 If both privacy and consent are documented and one or both are expired, OR neither 

privacy nor consent are documented, an X/exclamation point icon displays:  

 Clicking the Privacy/Consent Info button will launch the main Privacy/Consent 
Information screen from Patient Administration, where the user may make any 
needed updates. 

Prompt for Expired/Missing Information: If the system is set up to enforce privacy/consent 
configuration (via the Privacy/Consent Configuration screen in the System Administration 
Console), an Expired or Missing Privacy/Consent Information prompt will display in 
Patient Administration and Charge Entry if the user saves changes to a patient record that 
has missing and/or expired privacy/consent information. 
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System Administration 

Accounting Periods, Financial Groups Removed from 
Report 

Project #EHS-19905

Financial group information has been removed from the Accounting Period report in System 
Administration.   
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System Administration Console  

Clinic Configuration, NDC Columns Added to 
Prescribed Medications Starter Set  

Project #BHML3-397

A Show NDC Indicator option has been added to the Prescribed Medications starter set in 
the Clinic Configuration section of the System Administration Console. 

 
Selecting (checking) this option will display an NDC column in the Prescribed Medications 
main grid. An asterisk (*) will display for all medications that have an NDC number. 

Clinic Configuration, New Registry Reporting 
Configuration for Blood Lead Tests  
(FL Clients Only) 

Project #EHS-20058

To accommodate blood lead test reporting requirements on in-house equipment for Florida-
based clients, a Registry Reporting Configuration screen has been added to the Clinic 
Configuration section of the System Administration Console. 
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Access is defined by enabling the Registry Reporting Configuration option for the 
user in the System Administration mode of the Configure by User/ Configure 
by Section screens in Clinical Console Security. 

 
The following access levels are available: 

 Access – Enables users to access the screen. 

 Edit – Enables users to edit the CPT code selection and the trigger point on screen. 

 Delete – Enables users to delete a CPT code from the code table. 

The Registry Reporting Configuration screen enables SYSADM users to configure certain 
CPT codes in the system to automatically send blood lead results to the state when certain values 
are present on the appropriate order. 
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To configure CPT codes for the blood lead interface: 

1. Select (check) the Enable Blood Lead Interface checkbox in the Interface 
Information section. The Labs section will enable. 

2. Click  in the Code field and search for the appropriate CPT code to configure. A 
Starter Set Lookup dialog box displays. 

 
Search for and select the appropriate code and click Select to populate the Code field 
on the main screen. 

3. Select the appropriate trigger point (the point at which to send the lab results) from the 
Send Results upon drop-down list. Selections include Order Sign Off and Encounter 
Sign Off. 

4. Enter the appropriate Patient Population age range from which to send the results. 

5. Select the appropriate HL7 Template to use to send the results from the drop-down 
list. The Descriptive Name field will populate once a template is selected. 

6. In the Report Results Criteria section, enter the appropriate Component and Value 
configurations for the CPT code. 

7. Once the above information is entered, the record will automatically save and display on 
the main grid. 

 

Users may click  in the Edit column to edit the information in a particular record; the 
information will populate the appropriate fields and allows the user to make changes. 

8. Auditing – Users may click the Enable Blood Lead Interface hyperlink in the 
Interface Information section to display the interface enable audit. 
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The following information is available for viewing: 

 Audit User – Displays the user ID of the person that modified the audit (always 
SYSADM). 

 Audit Date – Displays the date the modification was made. 

 Audit Time – Displays the time the modification was made. 

 Enable Blood Lead Interface – Indicates (via Y or N) whether the interface 
was enabled or disabled for the in-house equipment. 

Configure SuccessEHS, Duplicate Patient Override 
Checkbox Removed 

Project #EHS-19761

The Duplicate Patient Override checkbox has been removed from the Patient 
Administration section of Configure SuccessEHS under Practice Configuration in the 
System Administration Cons 

Financial Classes, New Timely Filing Limit Option Project #EHS-20185

A Timely Filing Limit option has been added to the Financial Class dialog box in the 
Financial Class dialog box in Core Setup under Practice Configuration in the System 
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Administration Console: 

 
The Timely Filing Limit option allows users to enter a set number of days in the Timely Filing 
Limit field past which the claim is considered overdue for timely filing for all claims in the 
appropriate financial class. 

If the user chooses to enter a timely filing limit, the following message displays: 
“Saving the Timely Filing Limit will update every plan attached to this Financial Class. 
Would you like to continue?” 

 
Clicking OK will update all insurance plans associated to the appropriate financial class with the 
entered timely filing limit. Any existing information on the affected insurance plans will be 
overwritten. 

Clicking Cancel will cancel the setting of a filing limit to the financial class.  

Timely filing limits are editable and auditable in the Financial Classes screen, and will be 
reportable in Business Objects reports. 

Timely Filing in Claims Console 

Individual claims in Claims Console are color-coded to indicate the status of timely filing limits. 

 

 Claims in black text – The claim is within the timely filing limit. 
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 Claims in red text – The claim has exceeded the timely filing limit. An Exceeded label 
will also display in the Timely Filing column. 

 Claims in purple text – The claim is past due and has been marked for review. Past due 
claims marked for review that have also exceeded the timely filing limit will display in 
red text as indicated above. 

Filtering Timely Filing in Claims Searches 

In Claims Console, users can search for only those claims that have a Timely Filing alert 
attached to them by selecting (checking) the Timely Filing Alerts Only checkbox in the search 
section of the Claims Management screen. 

 
A Timely Filing column has been added to the search results grid that displays the number of 
days in which the timely filing limit will be reached; an Exceeded label indicates that the limit 
has passed. 

 



SuccessEHS Release Notes 7.20 26

 

 

© 2014 Greenway Health, LLC. All rights reserved. Confidential and proprietary. 
Not for distribution except to authorized persons. Last Modified: 12/11/14 

 

Timely Filing in Other Modules 

 Inquiry – A Timely Filing column has been added to the Balances By Visit grid in 
Inquiry that displays the number of days in which the timely filing limit will be reached 
(similar to Claims Management above). 

 

 Charge Entry alerts – Users with System Administration access can configure timely 
filing alerts to display for individual users in Charge Entry via the Timely Filing Alerts 
Configuration screen in the Additional Configuration section under Practice 
Configuration in the System Administration Console. 
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Users may select the appropriate user IDs in the Available Users column and click  
to move them to the Selected Users column. To remove one or more users, select the 

users in the Selected Users column and click  to return it to the Available Users 
column.  
Selected users will receive timely filing alerts in Charge Entry when a claim exceeds the 
timely filing limit. 

HIE Consent Configuration, Restrictions for 
Syndromic Surveillance Outgoing Messages 

Project #EHS-20347, EHS-20349

Restrictions are now in effect for all outgoing messages sent regarding syndromic surveillance. 

 Consent-based restrictions – Only patients with a signed HIE consent form (via 
the Privacy/Consent Information window in Patient Administration) will have 
syndromic surveillance messages sent when the ESB is submitted and the applicable 
financial group is configured (via the HIE Consent Configuration screen in the 
System Administration Console) to send data to the applicable HIE. If patient 
consent is not present and/or the financial group is not configured appropriately, no 
data will be sent. 

 Financial group restrictions – In addition, messages are also subject to financial 
group restrictions. If Financial Group A is configured to send messages to State X, 
then only messages generated for patients checked in to Group A will be sent. 
Messages will not be sent to State X from any other financial group. 

 


